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Why Do We Build Models/Simulations?

(Your answers)

When you have a working model and you are getting ready to present your project
remember your answers to this question. Does your project satisfy the reasons that
you have given? Are you expecting the judges to figure out what you have discovered

from your model or are you explaining to them what you have learned from your
model?
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Optimization and Models

Optimization is a formal way (among many others) for extracting information from a model.
Used in this way it is not the main purpose for the project. What type of information does it
produce?

Optimization can also take a major role in the project in studying which optimization
approaches work best. In this role the project compares optimization approaches.

Past projects that used optimization:

2009-2010 3rd place team: Los Alamos High School
To Kill a Flocking Bird (Peter Ahrens, Stephanie Djidjev,Vicky Wang, Mei Liu)
Applied brute force, bracketing, steepest descent and genetic optimization algorithms to
a NetLogo model of flocking birds.

2010-201 1 2nd Place Team: Los Alamos High School
BrilliAnts (Peter Ahrens, Dustin Tauxe, Stephanie Djidjev)
Investigated Ant Colony Optimizations
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Basic Definitions

e Optimization, or mathematical programming, is the study and practice of
seeking, in a systematic way, the maximum or minimum values of a function (the
objective function), and the values of the decision variables (the inputs to a given
function) where the maximum or minimum objective function values are found.
Complicating this in practice is that decision variables are often subject to
constraints, and that the nature of the objective function may make analysis
difficult.

® An algorithm is a step-by-step problem solving procedure. Algorithms can range
from very simple (e.g. cooking recipes, driving directions between two locations
on a map, the Sieve of Eratosthenes for enumerating prime numbers) to
moderately complicated (e.g. Runge-Kutta methods of numerical integration) to
very complicated (e.g. algorithms to maximize potential profits from oil-drilling
activities).

Computational Solution Techniques in Mathematical Programming

Saturday, October 20, 12



Basic Definitions (cont.)

® The feasible region is the set of decision variable values which satisfy all of the
constraints in a mathematical programming problem. Constraints define the
limits of the feasible region.

e A maximum or minimum (the plural forms are maxima and minima), is a point
in the feasible region where the value of the objective function can't be
increased (for a maximum) or decreased (for a minimum) by moving in any
direction in the local neighborhood. If this condition holds for the entire feasible
region, then the point is a global maximum or global minimum.; otherwise, it's a
local maximum or local minimum.

e [Extremum (pl: extrema) can be used to refer to either a minimum or maximum.

e Optimum (pl: optima) is a minimum or maximum (usually global), as relevant to
the stated problem. For example, if we're trying to minimize the objective
function, then the optimum is the point at which the objective function is
minimized.
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Basic Definitions (cont.)

® An exact algorithm is one which is mathematically guaranteed (under some
stated conditions) to arrive at the solution to a particular type of problem. For
some problems, there are known exact algorithms which are computationally
very efficient; for others, all known exact algorithms are computationally
expensive — prohibitively so, in some cases.

o NP-complete — computationally expensive usually requiring an exhaustive
search of all possibilities. NP is nondeterministic polynomial time. NP-hard is
similar complexity but without a formal proof.

® A heuristic algorithm is one which incorporates certain rules of thumb, or
experience-based rules. It ignores whether the algorithm can be
mathematically proven correct. In most cases heuristics require fewer
mathematical and logical operations than exact algorithms — though there is
no guarantee that the heuristic will arrive at the same solution.
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Optimization

® Sometimes more of an art than a mathematical science
® There is no “perfect” optimization method

e Powerful — worth $$$

° A 1% savings in operation costs can increase profit by 10%

e Used in nearly every business, engineering, science or professional field

e Many advances in the last decade (compare to most math disciplines with
little change in 100 years)

This makes it great material for a SC Project
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First Step: What is “Good”?

e Determine what you are optimizing - must be quantifiable

° Less fuel, less time, more widgets

e (ften called an objective function, cost function, fithess function, or an
evaluation function

e Evaluation functions should be written where the optimum is a
maximum or a minimum

A minimum will be assumed for the rest of this presentation
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Second Step: What are the
Independent Variables?

® (One variable

® Two variables
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Example: Global vs. Local Extrema

Consider the following graph. Assume that the decision space is represented by
the X values (limited to the visible width of the graph), and that the objective
function values are the Y values.

e At which of the labeled X values does the graph reach its minimum and
maximum Y values? These are the global minimum and global maximum (i.e.
global extrema).

e Which of the labeled X values are local — but not global — extrema?
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Considerations

® Methods work best with smooth functions

® Independent variables should not themselves be correlated. If they
are, as they often are, the optimum values of the independent
variables may be wildly off. Yet the minimum of the objective function

will be reasonable.

® There is no guarantee in most of the methods of a global minimum,
just a local minimum
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Tricks

® |solate independent variables and solve

° Similar to technique in “Clue”®

e Example — Objective function is highest
level of ant activity. Independent variable
are hours of daylight and temperature.

e Take data at same temperature but on
different length days
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What is a Good Method?

Method should evaluate the function as few times as possible or
fewest number of steps/guesses

Parallel methods can work better with more guesses at each step
rather than the least number of evaluations. For parallel methods we
should redefine steps to consist of one or more guesses or function
evaluations

A good method for one problem is not necessarily a good method for
another problem

Robustness (i.e. working for all cases) can be more important than
efficiency or fewest steps
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Types of Problems

® Linear — treated in Operations Research, Business Schools. A function example is
22 |bs of plastic per 100 widgets produced. (Note: Operations Research also
delves into most of the following types of problems also.)

® Non-linear — occurs more often in science where inter- relationships between
variables are more complex. A small change in an independent variable can
generate large changes in the objective function.

e (Complex problems (or NP-complete) — a solution
can be verified, but there is no known efficient way
to locate a solution. Examples are the traveling
salesman problem or the knapsack problem. While
an optimum solution cannot be easily computed, a
near-optimal solution (good enough solution) can be
found. Computing a “perfect” chess move is a good
example of this type of problem.
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Simple Mathematical Optimization

e Optimum must be at a point where the slope is zero. In math this is expressed
as when the derivative is zero. This point is a local minimum. However, it
doesn't necessarily follow that any such zero-slope point is a global optimum
for the function.

® The points where the slope is zero are the set of candidate points. Some
adjustments must be made

° Points that violate the constraints must be discarded (such as negative values that violate physical
reality)

° Add to the set of points the intersections of the optimization surface and the constraints.

e \We now examine this set to see which are global extrema, and which of those
IS a minimum extrema.
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Example: Maximize Fenced-in Area

Imagine that you own a piece of land, located at the bottom of a cliff. You
intend to fence in a portion of this land, as a pen for animals.

® You have enough material for 100' of fence.
¢ For simplicity, you've decided to make the pen rectangular in shape.

® [For economy, you're going to use the cliff wall as one side of the
rectangle; you don't need to put fencing material on that side.

Your task is to find the dimensions for the fenced-in area that maximize the
area enclosed, using only the materials you have.

e What mathematical function describes the area enclosed by the fence,
In terms of its dimensions?

® Are there any constraints on the dimensions? What are they?
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Example: Maximize Fenced-in Area (cont.)

We can draw a simple diagram of the problem, as follows:

cliff

Our task is to find the value of x that gives the
largest value for f(x). We recognize f(x) as a
quadratic of the form f(x) = ax2 + bx + ¢. From
intermediate algebra, we remember that the vertex
of the parabola described by the quadratic is found
where x = -b/2a.

In this case, b=-100, and a = 2. Computing x and
the resulting area, we get the maximum area (1250
ft2), when the dimensions are 25' X 50'.

area = f(x)= x(100 — 2x)=100x — 2 x°
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Three Main Approaches

e Direct solution — used for linear, quadratic and other simpler problems where
simple analytic approaches are workable.

° Simplex Method or Linear Programming are typical solution techniques. Also Lemke's algorithm for
quadratic programming, the stepping-stone algorithm for the transportation problem, the Hungarian
method for the assignment problem, and Dijkstra's algorithm for finding the shortest path on a network

® [terative solution methods — take slight perturbations of the initial guess and
search in the direction with the better value.

e  Steepest Descent and Conjugate Gradient solvers are examples of methods to solve these
problems

e Directed random search methods — search algorithms have randomness as a
key element, where the sampling distributions are influenced by the objective
function, and where the amount of randomness tends to decrease as the number

of iterations increase.

e  Simulated Annealing, Genetic Algorithms (GA), Ant Colony optimization, and Particle Swarm
Optimization are some of the methods most suitable for this class of problems.
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Direct Methods
Linear Programming via the Simplex Method

When the objective function is linear, all the constraints are linear, and the decision
variables are continuous, we have a linear programming problem (LP). In 1947,
George Dantzig invented the simplex method to solve linear programming problems.
In very general terms, this algorithm proceeds as follows:

® Set up the problem as a system of linear equations, with more variables than
equations (new variables are added as needed, to turn inequalities into equations).

e By a series of matrix “pivoting” operations, move from one feasible solution to
another, where each successive solution improves the objective function.

® When the objective function cannot be improved further, we've found the optimum.

This process is as a series of moves from vertex to vertex, along the edges of an n-
dimensional convex polytope, with each move improving the objective function. When

none of the edges lead in a direction that improves the objective function, we've found
the optimal solution.
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Exercise: Maximize Profit on Exports’

A firm exports two types of machines: P and Q. Type P occupies 2m3 of space,
and type Q requires 4m3. The mass of type P is 9kg; type Q masses 6kg. The total
available shipping space is 1,600m3 and the total mass of the machines cannot
exceed 3,600kg. The profit on type P is $100 and the profit on type Q is $80. How
many of each machine must be exported to maximize profit, and what is that
maximum profit?

Here's the LP formulation, along with a graphical view of the feasible region (i.e.
the region containing all points satisfying the constraints):

p = number of type P machines exported 200

g = number of type Q machines exported 0
Maximize:
100p + 80g
Subject to: 400
2p + 4qg =< 1600
O9p + 6g =< 3600
p > 0
g = 0
0 400 800

Computational Solution Techniques in Mathematical Programming

Saturday, October 20, 12



Exercise: Maximize Profit on Exports (cont.)

We could easily solve this example by computing the profit at all four vertices of the
feasible region and selecting the vertex with the highest profit. The advantage of the
simplex method is that it almost never needs to visit each vertex; it always moves along
the edge that improves the objective function most. This is a big advantage when
problems are much larger than this one.

There are many libraries that implement the simplex method. For this example, we'll
use Apache Commons Math (http://commons.apache.org/math), an open source Java
library.

1. In NetBeans, open the SimplexExample project.

2. Openthe SimplexExample. java file from the org.nm.challenge.optimization
source package.

3. Complete the code by following the instructions that begin on line 72 of
SimplexExample. java (hint: review the constants declared in lines 42-48).

4. Compile and run the program. What's the result?

5. Is the answer integral? If not, how should we interpret it?
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Exercise: Giapetto's Woodcarving

Giapetto's Woodcarving Inc. manufactures two types of wooden toys: soldiers
and trains. A soldier sells for $27 and uses $10 worth of raw materials. Each soldier
that is manufactured increases Giapetto's variable labor and overhead costs by
$14. A train sells for $21 and uses $9 worth of raw materials. Each train built
increases Giapetto's variable labor and overhead costs by $10. The manufacture of
wooden soldiers and trains requires two types of skilled labor: carpentry and
finishing. A soldier requires 2 hours of finishing labor and 1 hour of carpentry labor.
A train requires 1 hour of finishing and 1 hour of carpentry labor. Each week,
Giapetto can obtain all the needed raw material but only 100 finishing hours and 80
carpentry hours. Demand for trains is unlimited, but at most 40 soldier are bought
each week. Giapetto wants to maximize weekly profits (revenues — costs).

Operations Research: Applications and Algorithms, 4th Edition, by Wayne L.
Winston (Thomson, 2004).

More detail on this problem at:
http://www.ibm.com/developerworks/linux/library/l-glpk1/

Computational Solution Techniques in Mathematical Programming

Saturday, October 20, 12



Exercise: Giapetto's Woodcarving

To summarize the important information and assumptions about this problem:

There are two types of wooden toys: soldiers and trains.

A soldier sells for $27, uses $10 worth of raw materials, and increases variable

labor and overhead costs by $14.

A train sells for $21, uses $9 worth of raw materials, and increases variable labor

and overhead costs by $10.

A soldier requires 2 hours of finishing labor and 1 hour of carpentry labor.

A train requires 1 hour of finishing labor and 1 hour of
carpentry labor.

At most, 100 finishing hours and 80 carpentry hours are
available weekly.

The weekly demand for trains is unlimited, while, at
most, 40 soldiers will be sold.

Figure 4. Giapetto's feasible region
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The goal is to find the numbers of soldiers and trains that will maximize the weekly profit.
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Exercise: Giapetto's Woodcarving

1. Install libgplkO, libglpk-dev, glpk-utils, glpk
2. Copy the file giapetto.mod from the giapettoLP directory

3. glpsol -m giapetto.mod -o giapetto.sol

Problem: giapetto
Rows: 4
Columns: 2
Non—-zeros: 7
Status: OPTIMAL

Objective: profit = 180 (MAXimum)

No. Row name St Activity Lower bound Upper bound Marginal
1 profit B 180
2 carpentry NU 80 80 1
3 finishing NU 100 100 1
4 soldier_demand
B 20 40
No. Column name St Activity Lower bound Upper bound Marginal
1 scldiers B 20 0
2 trains B 60 0
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Specialized Linear Programming Variations

Some optimization problems are better suited to more specialized methods than the
general-purpose simplex method. Examples include:

® The transportation problem: Given n sources, each with a supply s, of some commodity;
m destinations, each with a demand dn, for that commodity; a cost ¢j for transporting one
unit of the commodity from source i to destination j; find the transportation scheme that
satisfies the demand at minimum cost. Solution techniques for this problem exploit the
network nature of the problem to solve it more efficiently.

® The assignment problem: Given nresources, and m tasks (where m = n), where
there is a cost ¢j associated with assigning resource /1o task j, and where each
resource must be assigned to exactly one task, and each task may be assigned a
maximum of one resource, find the set of assighments that minimizes the total cost.The
most well-known technique for solving this type of problem is the Hungarian method.

® In general, problems where some or all decision variables must have integral
values often require specialized algorithms. This is especially the case where
only the values 0 and 1 are allowed.
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Interior Point Solution Techniques

While the simplex method and its variants are usually very good, and they're
widely used, there are extreme instances where the simplex method gives close to
worst-case performance. The first practical alternative to the simplex method for
these problems was Karmarkar's algorithm, invented in 1984.

Karmarkar's algorithm can be viewed as moving through the interior of the
polytope, in a relatively small number of steps. For this reason, we refer to this and
similar methods as interior point methods.

The computational cost of formulating LPs for interior point methods, and of
computing each step through the interior of the polytope, are very high, but the
number of iterations required for solution is low. This trade-off makes these
techniques well suited to certain types of very large problems, but poorly suited to
most others.
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One-dimensional Methods:
Bracket methods

® For single variable cases with unimodal objective function (no local minima)

e Take 3 starting points widely separated. The middle point, b, must be lower
than the other two. Then take a point in between a-b or b-c. Suppose we take
a point in b-c called d. If d > b, then the new bracket tripletis a <b < d, else,
the new tripletis b <d <c.

e The various methods use different ways to . P
estimate the best point to take for the next \ d/,—/*/
guess. Golden mean method uses the X _—
golden ratio. Other methods use a L\ Y
parabolic function or first derivatives.

Computational Solution Techniques in Mathematical Programming

Saturday, October 20, 12



Exercise 1 — Bracket Method

Find the minimum of f(x) = cos(x) + 1, which occurs at x = []. The starting interval is
(0,6), with an initial guess for the minimum of 2.

|. Install libgslOldbl, libgsiO-dev

2. Open up Eclipse. Select New Project, New C Project, Executable:Empty Project. Put
in name of project — Bracket. Click through rest of windows.

3. Right click on Bracket in Project Explorer. Select new: C Source file. Name it
bracket.c. Enter source from BracketExample/bracket.c or http://www.gnu.org/
software/gsl/manual/html node/Minimization-Examples.html

4. Right click on Bracket again and select Properties all the way down at the bottom.
Open up C/C++ Build and select settings. Select GCC C Linker:Libraries. Add the
libraries gsl and then gslcblas. Compile project.

5. Select Run menu: Run configurations. Click on add (small page with plus sign at
upper left). Setup run configuration and run problem.

6. See the Appendix for platform specific instructions.
Try the other minimization algorithms in the library, golden section and quad golden. The
reference page is http://www.gnu.org/software/gsl/manual/ntml node/Minimization-
Algorithms.html. The function names are gsl_min_fminimizer_goldensection and
gsl_min_fminimizer_quad_golden. Which works best for this problem?

Computational Solution Techniques in Mathematical Programming

Saturday, October 20, 12


http://www.gnu.org/software/gsl/manual/html_node/Minimization-Examples.html
http://www.gnu.org/software/gsl/manual/html_node/Minimization-Examples.html
http://www.gnu.org/software/gsl/manual/html_node/Minimization-Examples.html
http://www.gnu.org/software/gsl/manual/html_node/Minimization-Examples.html
http://www.gnu.org/software/gsl/manual/html_node/Minimization-Algorithms.html
http://www.gnu.org/software/gsl/manual/html_node/Minimization-Algorithms.html
http://www.gnu.org/software/gsl/manual/html_node/Minimization-Algorithms.html
http://www.gnu.org/software/gsl/manual/html_node/Minimization-Algorithms.html

Exercise 2 — Bracket Method

Take your favorite Netlogo model. Let's say that it is a fire egress model. For one
slider, optimize the number of people that escape. Note that at each input value, you

will have to take a statistical average of the result because of the random number
used in the simulation.
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Line Search Methods with Derivatives

® Two points uniquely determine a line. Where is the minimum of a line?

® Two points and a derivative (slope) at the first point determine a parabola. There is a
unique minimum or maximum to a parabola. Where is this minimum or maximum?

® Two points and derivatives at both points determine a cubic spline.

® How are some ways that one can get a polynomial of order greater than one without
using derivatives?
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Multivariable Methods
Rosenbrock Test Case

If you have a Mac, open Grapher (Applications -> Utilities -> Grapher). Create a 3-
D plot. Enter the equation:

Zz = (1-x)2 + 100(y-x2)2

Go to Format -> Axes & Frame. Set the following:

e Abscissa: [-2, 2]
*Ordinate: [-2, 2]
*Height: [0, 2500]

Right click on the plot and edit the appearance.
Change Checkerboard to Height. If the plot
appears jagged as you play with it then you might
want to increase the resolution and reload.

The minimum of this function is at (I,1).
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Multivariable Methods:
Steepest Descent

|.  Multivariable case starts by choosing a direction. A
common choice is the steepest descent.

2. Use a one-dimensional line search to decide how far to
go in this direction. Do we need to find an optimum
for the one-dimensional line search?

3. Select a new steepest descent direction and repeat the
line search. Iterate.

See Numerical Recipes for description, method and X
sample code. "
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Multivariable Methods
Conjugate Gradient

Al
=/

Computational Solution Techniques in Mathematical Programming

® Trick here is to take the conjugate
to all previous search directions to
try and force solution "down the
valley"

e Why are valleys important? Usually
one independent variable is
stronger than the other, producing
a long valley
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Multivariable Methods
Rosenbrock Test Case

Shown here is the steepest
descent algorithm applied to the
Rosenbrock problem. The narrow
curved valley causes the method to
take a lot of steps. The conjugate
gradient approach was developed 054
to work better on this type of
problem. (From wikipedia) £

ORNL has pictures of various

optimization methods appliedtothe | ~ ~ ~ ~ ~—~*9 _— -~~~/ / /
Rosenbrock and Beale functions: 2 00 02 04 X1
http://www.phy.ornl.gov/csep/mo/

nodel7.html
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Multivariable example
® Function: z = 10(x-1)2+(y-2)2+30
e Gradientis [20(x-1), 2(y-2)]"

® Optimum step size « can be calculated analytically. For any
practical problem a line search method will need to be used.

[100(x-1)?+(y-2)?]
“= T20000x-1)%42(:-2)7]
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Graph the results (Mac Only)

e Graph the function by going to e O D=8 -4

=0 P20 2 s

Applications->Utilities->Grapher .

Reratiom

e select 3D Graph and White and
enter the equation:

z = 10(x-1)2+(y-2)2+30

® Then go to Format->Axes and
Frame and select Height Axis and
make it go from O to 700.

® Type in your points from one of the methods in the following slides or create a text
file with your points to import. Separate the numbers with "," and rows with ";" with
all the points on one line with no spaces. Go to grapher and click on "+" and New
Point Set and Edit Points, then import your *.txt file.
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Steepest Descent

Choose initial guess x
Evaluate f(X)

Evaluate s = -Vf(x)
Find =« to minimize f(X + «S)

X=Xt x§

This example uses the analytical step size.

® Edit steep.c and set x[0] and x[|] to your initial guess.
® Compile with gcc -o steep steep.c fandg.c

® Run with ./steep

Computational Solution Techniques in Mathematical Programming

Saturday, October 20, 12



Polak-Riviere Nonlinear Conjugate Gradient

This example uses a cubic line search to find the step size.

® Edit polriv.c and set x[0] and x[|] to your initial guess.
® Compile with gcc -o polriv polriv.c cubsrch.c fandg.c

® Run using ./polriv

Computational Solution Techniques in Mathematical Programming
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Multivariable Methods:
A NetLogo Approach

|. Define an objective function f.
2. Place all the sliders in the middle of their ranges

3. Either fix random number generators at the middle or use averages of
several runs.

4. Figure out which inputs are the most important by moving one slider and
computing (f(ixe) -f(x1))/(x2 - x1) where x represents the current slider input
while the other inputs are held constant. Repeat for all inputs. The larger
absolute numbers are the most important inputs at this point. Choose a
direction (e.g. move the most important slider two units, the next one unit,
etc.).

5. Do aline search in the chosen direction.

6. Go to step 4 and compute new differences and repeat the process until you
find a rough optimum input.

7. What inputs are the most important for your model? What does the rough
optimum input tell you about your model?
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Multivariable Methods:
A NetLogo Approach (cont.)

So simplifying this to an extreme:

® Choose the slider that makes the biggest difference.
® Adjust it until you have an optimum.

® Choose the slider that makes the next biggest difference (direction is orthogonal to
the first).

® Adjust it until you have an optimum.

® Repeat until you have gone through all the sliders, then start again from the slider that
makes the biggest difference.
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Directed Random Search Methods

PLAYER'S FLEET

® Best where optimization surface is complex or
has local minima

® Has some randomness in the solution
technique

¢ Think of method you use for “Battleship™®

® Heuristic based methods work better than
exact algorithms

e Examples of Solution Methods
e  Simulated Annealing
®  (Genetic Algorithms
e Ant Colony Optimization

® Particle Swarm Optimization

Computational Solution Techniques in Mathematical Programming
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The Traveling Salesman Problem

One example of this is the traveling salesman problem (TSP):

Given n cities (points), with a distance dj between cities j and j,

find the route through all the cities that minimizes the total distance, and returns to the
starting point. Exact solution techniques are very expensive once the number of cities
moves into the thousands (not that uncommon, when we start seeing such parallels as
those between points on a circuit board and cities on a map) and may be years of CPU
time.

One of the best heuristics for the TSP is the Lin-Kernighan algorithm, introduced in

1973. This algorithm works by adaptively swapping pairs of tour fragments to formulate
an improved tour at each step.
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Simulated Annealing

In simulated annealing (which refers to the analogy with how metals cool and
anneal), the solution method is allowed to sometimes take an upward step rather
than always going in the downward direction. This can be helpful in avoiding local
minima and stepping “over the hump” to the global minimum. The frequency of the
upward step is always an heuristic algorithm which must be developed for the

problem at hand.
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Exercise - Simulated Annealing

Traveling Salesman Problem

e Open up Eclipse. Select New Project, New C Project, Executable:Empty
Project. Put in name of project — Traveling_Salesman_Problem. Click through
rest of windows.

® Right click on Traveling_Salesman_Problem in Project Explorer. Select new:
C Source file. Name it siman_tsp.c. Enter source from
TravelingSalesmanProblem/siman_tsp.c or search the web for siman/
siman_tsp.c.

e Right click on Traveling_Salesman_Problem again and select Properties all
the way down at the bottom. Open up C/C++ Build and select settings. Select
GCC C Linker:Libraries. Add the libraries gsl and then gsicblas. Compile
project.

e Select Run menu: Run configurations. Click on add (small page with plus sign
at upper left). Setup run configuration and run problem.

® To plot results, run “sh plot.sh” or “sh plotgif.sh”. Look at the files *.eps or *.gif.

Computational Solution Techniques in Mathematical Programming

Saturday, October 20, 12



Traveling Salesman Problem Results

TSP — initial—order TSP final —-order
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Particle Swarm Optimization

Description: http://ccl.northwestern.edu/netlogo/models/ParticleSwarmOptimization

For particle swarm optimization, each particle is given a position and velocity.

Then an acceleration is applied to each particle towards its “personal best” and

towards the “global best”. The further away from these locations, the stronger
the acceleration towards them. A random factor is also applied to the

acceleration forces.

Exercise — Start up Netlogo
4.1.3. Open up the models
library and go to Sample
Models:Computer
Science:Particle Swarm
Optimization (Uri Wilensky,
Northwestern University).
Setup and run.

File Edit Tools Zoom Tabs Help

Interface Information Procedures
’ B + “ue Button = l

attractionto est 1.0

00000

I Settings

Command Center

CCCCC

observer>
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Genetic Algorithms

A genetic algorithm (GA) is a heuristic that emulates some of the mechanisms of
evolution to find a good enough solution to a problem. A GA starts with a population of
randomly-generated solutions to a problem; each of these is encoded as the genome
of an individual member of the population. Then, we follow these steps to produce
successive generations of the population:

e Each member of the population is evaluated to assess its fithess

® A subset of the population is chosen to survive to the next generation. This
selection is random, but individuals with better fitness are more likely to be
selected.

® o replace individuals that don't survive, a subset of the population is chosen
(randomly again, but again weighted to the most fit) to reproduce.

® The next generation is produced by combining the genomes from pairs of
individuals selected for reproduction.

e Optionally, an offspring's genomes may be mutated slightly in a random fashion.
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Exercise: TSP with a Genetic Algorithm

Start up netlogo, v4.1RC5. Open the models library and select Sample
Models:Computer Science:Simple Genetic Algorithm(Uri Wilensky, Northwestern
University). Set it up and run it.
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Convex Hull Construction Heuristic for TSP

One relatively intuitive and effective approach to the TSP begins by finding the subset
of points, and the tour connecting them, such that all of the points are either in the
subset, or in the interior of the polygon formed by the tour. This polygon is called the
convex hull of the full set of points. (The concept of the convex hull can be applied to
n-dimensional polytopes, but the application to the TSP is primarily of use in two
dimensions only.)

Once we have this initial subset and tour (collectively called a sub-tour), we add to it
progressively, incorporating an additional point at each step. One reasonable heuristic
IS to select at each step the point that results in the smallest immediate increase in the
length of the sub-tour; this type of heuristic is referred to as “greedy”, since decisions
are based only on the cost/benefit of immediately available alternatives.

When all points in the set are incorporated into the sub-tour, the
algorithm is done.
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Exercise: TSP w/ Convex Hull &
Greedy Insertion

Go to the site

http://www-e.uni-magdeburg.de/mertens/TSP/node2.html

Try running the second applet. Select a large number of nodes (25) to get a better
idea of how the algorithm performs. Then select run. Select solve to see how it
compares to the best solution.
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Linux setup (64 bit Ubuntu)

® Netlogo
® Run the Netlogo installer
® Eclipse for C programs

e Install Eclipse by running the eclipse-cpp-galileo-SR1-linux-gtk-x86_64
installer

e |nstall Java by running the jdk-6u16-nb-6_7_1-linux-ml.sh installer
e |nstall compilers and supporting tools with the package manager
® Duild-essential
e |nstall libraries and gnu software with the package manager
® |ibgslOldbl and libgslO-dev
e (glpk-utils
e plotutils
e When setting up the compiling in Eclipse
e Addto GCC C Linker:Libraries
® (sl
® gslcblas
® Netbeans for Java programs
® Run the netbeans installer
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Windows Setup

® Netlogo

° Run the Netlogo installer

® Eclipse for C programs

° Install Wascana by running the Wascana installer (http://code.google.com/a/eclipselabs.org/p/
wascana/ - download wascana-1.0-setup.exe)

° Install libraries and gnu software by running gnu installers (http://ascend4.org/
Binary installer for GSL-1.13 on MinGW) for

e gsl1.13

° Add to system path by opening up control panel, search for system environment and adding to the
end of the path

° ;C:\Program Files (x86)\GnuWin32\bin;C:\Program Files (x86)\Wascana\mingw\bin
° When setting up the compiling in Eclipse
° Add to GCC C Compiler:Directories
° "C:\Program Files (x86)\GnuWin32\include"
° Add to GCC C Compiler:Symbols
° GSL_DLL
° Add to MinGW C Linker:Libraries
° Libraries
° gsl
° gslcblas
° Library search path
° "C:\Program Files (x86)\GnuWin32\lib"

® Netbeans for Java programs
o Run the netbeans installer
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OSX (Mac)

® Netlogo

® Place NetlLogo in the Applications directory. Double click on the NetLogo icon.
® NetBeans

® Run the NetBeans installer
® (C/C++ Code

e |nstall Xcode development tools. These should be on your OS disk or
register and download at http://developer.apple.com/technology/
xcode.html. More recent Macs can install Xcode from the App store.

e |nstall MacPorts (choose the version for your OS): http://
www.macports.org/install.php If necessary update using sudo port -d
selfupdate

e Make the following directory and cd to it: /opt/local/bin/portsiocation/
dports/gsl

e Then install the Gnu Scientific Library (sudo port install gsl)

* Running from the command line

e Copy SurfaceMin.c and myfunction.c to a directory. Then type the
following: gcc -o multimin SurfaceMin.c myfunction.c -Wall -l/opt/
local/include -L/opt/local/lib -Igsl -Igsicblas

e To run the program ./multimin
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OSX (Mac) (cont)

To run the program in the Xcode IDE:

1.

N O s W

Open XCode (/Developer/Applications/ and drag Xcode.app to your
Dashboard.)

Then open File/New Project...

In the "New Project" Assistant, expand the "Command Line Utility" group.
Select "Standard Tool"

Click "Next"

Give a project name (MultiMin) and directory, then click "Finish".

Press Cmd-Shift-R to open the Console window. Output will appear there.

Project->Add to Project and add SurfaceMin.c and myfunction.c. Delete main.c.

Edit Project->Edit Project Settings
Under Search Paths:

Add to User Header Search Paths /opt/local/include
Add to Library Search Paths lopt/local/lib/

Under Linking:

Add to Other Linker Flags: -lgsl -Igslcblas

Set the Architecture to Native Architecture
Click the "Build and Go" toolbar button.
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